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Preface

Sun Directory Services provides two tools for browsing the directory content:

� Deja is a JavaTM directory editor that provides a secure and simple way to create,
modify, delete, search, and rename directory entries.

� The Web Gateway provides an end-user interface to a Sun Directory Services
directory from any web browser. You can use this interface to browse the directory,
to search for and read entries, and to modify some directory information.

The Sun Directory Services 3.1 User’s Guide describes how to use Deja and the Web
Gateway. This guide is aimed at directory users who are responsible for maintaining
the directory content. It does not describe how to install, configure or administer Sun
Directory Services. If you need information about any of these tasks refer to the Sun
Directory Services 3.1 Administration Guide.

How This Book Is Organized
The Sun Directory Services 3.1 User’s Guide contains the following chapters:

Chapter 1 briefly introduces Deja and the Web Gateway. It explains the benefits of
using each tool.

Chapter 2 describes Deja’s standard functionality and explains how it is used to
search, edit, create and delete entries.

Chapter 3 describes Deja’s functionality for NIS users.

Chapter 4 describes Deja’s functionality for RADIUS users.

Chapter 5 describes the Web Gateway and explains how it is used to read and
modify directory entries.
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Appendix A describes the structure of the Deja.properties file, and how to
modify Deja properties.

Appendix B describes the dejasync command line utility and how it is used to
synchronize the Deja.properties file with the mapping files.

Related Books
The document set for Sun Directory Services also contains:

� Sun Directory Services 3.1 Administration Guide

Standards Reference
The Sun Directory Services are based on the following Internet standards and
proposed standards:

� RFC 1777 Lightweight Directory Access Protocol

� RFC 1778 The String Representation of Standard Attribute Syntaxes

� RFC 2138 Remote Authentication Dial In User Service

� RFC 2139 RADIUS Accounting

� RFC 1565 Network Services Monitoring MIB

� RFC 1567 X.500 Directory Monitoring MIB

� RFC 2222 Simple Authentication and Security Layer (SASL)

� RFC 2251 Lightweight Directory Access Protocol (v3)

� RFC 2252 Lightweight Directory Access Protocol (v3) Attribute Syntax Definitions

� RFC 2253 Lightweight Directory Access Protocol (v3) UTF-8 String Representation
of Distinguished Names

� RFC 2254 The String Representation of LDAP Search Filters

� RFC 2255 The LDAP URL Format

� RFC 2256 A Summary of the X.500(96) User Schema for Use with LDAPv3

� RFC 1274 The COSINE and Internet X.500 Schema

� draft-byrne-alias-00.txt

� draft-howard-nis-schema-04.txt

� draft-ietf-asid-ldapv3-referral-00.txt
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� draft-ietf-asid-ldapv3-tls-02.txt

� draft-ietf-asid-ldapv3-lang-02.txt

� draft-ietf-asid-ldapv3-ext-04.txt

� draft-ietf-asid-ldif-02.txt

� draft-ietf-radius-auth-servmib-01.txt

� draft-ietf-radius-acc-servmib-01.txt

� draft-ryan-java-00.txt

The Sun Directory Services support the following OSI standards:

� ITU-T X.500 1988 Recommendations

� ITU-T X.208 Abstract Syntax Notation One (ASN.1)

� ITU-T X.209 Basic Encoding rules (BER)

Ordering Sun Documents
The SunDocsSM program provides more than 250 manuals from Sun Microsystems,
Inc. If you live in the United States, Canada, Europe, or Japan, you can purchase
documentation sets or individual manuals using this program.

For a list of documents and how to order them, see the catalog section of the
SunExpressTM Internet site at http://www.sun.com.sunexpress .

Accessing Sun Documentation Online
The docs.sun.com web site enables you to access Sun technical documentation
online. You can browse the docs.sun.com archive or search for a specific book title
or subject. The URL is http://docs.sun.com .

What Typographic Changes Mean
The following table describes the typographic changes used in this book.
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TABLE P–1 Typographic Conventions

Typeface or
Symbol Meaning Example

AaBbCc123 The names of commands,
files, and directories;
on-screen computer output

Edit your .login file.

Use ls -a to list all files.

machine_name% You have mail.

AaBbCc123 What you type, contrasted
with on-screen computer
output

machine_name% su

Password:

AaBbCc123 Command-line placeholder:

replace with a real name or
value

To delete a file, type rm filename.

AaBbCc123 Book titles, new words or
terms, or words to be
emphasized

Read Chapter 3 in User’s Guide. These
are called class options.

You must be root to do this.

Shell Prompts in Command Examples
The following table shows the default system prompt and superuser prompt for the
C shell, Bourne shell, and Korn shell.

TABLE P–2 Shell Prompts

Shell Prompt

C shell prompt machine_name%

C shell superuser prompt machine_name#

Bourne shell and Korn shell prompt $

Bourne shell and Korn shell superuser prompt #
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CHAPTER 1

Introduction

Sun Directory Services provides two graphical interfaces that are used to view or
modify information in the directory:

� Deja

Deja is a JavaTM directory editor suitable for all day-to-day management of the
directory contents. With the tool you can search for and view entries, create and
modify entries, delete entries, and copy and paste entries.

� Web Gateway

The Web Gateway is designed for quickly viewing the contents of the directory,
searching for entries in the directory, and modifying some directory information.
Its limited functionality makes it unsuitable for more complicated operations. It
should not be used as a substitute for Deja.

Both tools can be connected remotely or locally to a Sun Directory Server. They both
provide simple ways to view the contents of the directory.

Deja
Deja provides a comprehensive user interface suitable for maintaining the directory
contents. Figure 1–1 shows the Deja Create panel. The tool is split into four areas, the
toolbar, the browser window, the function window, and the status bar. The toolbar,
browser window, and status bar are optional.

When you click on an icon in the toolbar or select an option from the Directory
menu, the appropriate screen is displayed in the function window.

1



Browser
Window

Toolbar

Function
Window

Status Bar

Figure 1–1 Deja Directory Editor

The toolbar uses a number of icons which have specific functions. Refer to Table 1–1
for a description of the icons and their functions.

TABLE 1–1 Deja Toolbar Icons

Icon Use

Login

Click this icon to login to the directory
server. You must login to modify the
contents of the directory.

Search

Click this icon to search the directory for
entries.

View

Select an entry in the directory browser
window and click this icon to view the
values of the attributes of an entry.
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TABLE 1–1 Deja Toolbar Icons (continued)

Icon Use

Create

Click this icon to create a new entry in the
directory.

Modify

Select an entry in the directory browser
window and click this icon to modify the
entry’s properties.

Rename

Select an entry in the directory browser
window and click this icon to modify the
Relative Distinguished Name of the entry.

Delete

Select an entry in the directory browser
window and click this icon to remove an
entry from the directory.

Cut

Select an entry in the directory browser
window and click this icon to cut the entry
from the directory, and retain a copy in the
clipboard.

Copy

Select an entry in the directory browser
window and click this icon to copy the entry
into the clipboard.
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TABLE 1–1 Deja Toolbar Icons (continued)

Icon Use

Paste

After an entry has been cut or copied to the
clipboard, select a parent entry in the
directory browser window and click this
icon to paste the entry as a child of the
selected entry.

Help

Click this icon to diplay the online help.

Web Gateway
The Web Gateway provides an interface to a Sun Directory Services directory from
any web browser. You can view the directory, search for and read entries, and
modify some directory information. This is useful for checking information in the
directory, but it is a general-purpose tool and should not be used in place of Deja.
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Figure 1–2 Web Gateway Directory Specific Entry Page

Figure 1–2 shows the naming contexts defined for the directory, and provides access
to the schema.

Starting the Directory Server Daemons
Deja requires the directory services daemon, dsservd , to be running on the
directory server. In addition, the Web Gateway requires the web gateway daemon,
dswebd , to be running on the server that holds the directory. Before you start Deja or
the Web Gateway, make sure that the appropriate daemons are running. If they are
not, start them as described in the following section.
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Starting the dsservd and dswebd Daemons
To start the directory server daemon, dsservd , as root type:

# /etc/init.d/dsserv start

To start the web gateway daemon, dswebd , as root type:

# /etc/init.d/dsweb start

When you install Sun Directory Services, these commands are added to the system
startup file, so that all the server daemons are started automatically when the
machine is rebooted.
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CHAPTER 2

Deja — Standard Operations

Deja is a Java directory editor that provides a secure and simple way to create,
modify, delete, search and rename directory entries.

It runs locally or remotely through a fully Java compatible web browser like
HotJavaTM , or it runs locally as a stand-alone Java application on a machine with a
Java Virtual Machine. If it is running locally as an application, it requires JDK 1.1.5 or
compatible versions.

If you try to run Deja through a browser that is not fully Java compatible, Deja may
not run correctly. Deja has been tested with the following browsers:

� Netscape NavigatorTM 4.0.5 running on Windows ‘95 with AWT 1.1.5. Netscape
4.0.5 does not support Deja’s default encryption method — CRAM-MD5. You
must set the STANDARD_SECURITY_AUTHENTICATIONtoken in the
Deja.properties file to simple . See “General Parameters” on page 62 for
information.

� HotJava version 1.0.1 running on Solaris. Before running Deja through HotJava,
you must set the hotjava.default.security variable to low in the
.hotjava/properties file in your local directory.

Starting Deja
There are four methods for starting Deja:

� Remotely, through the Sun WebServerTM , which you can download free of charge
from http://www.sun.com/webserver

� Remotely, through any other web server

� Locally, without a web server, by opening the Deja.html file in a web browser
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� Locally, as a Java application, on a machine with a Java Virtual Machine

To connect to the directory server, Deja requires that the dsservd daemon is
running on the server that holds the directory. If the dsservd daemon is not
running, Deja will start but is unable to connect. In this case, start dsservd as
described in “Starting the dsservd and dswebd Daemons” on page 6. Then connect
to the directory server as described in “Reconnecting Deja to the Directory Server”
on page 13.

Displaying Deja Remotely Through the Sun
WebServer
1. Set the documentation root for the Sun WebServer to /opt/SUNWconn/html .

Refer to the Sun WebServer documentation for instructions.

2. Start the Sun WebServer.

Refer to the Sun WebServer documentation for instructions. The Sun WebServer
must be running on the same machine as the dsservd daemon.

3. Open the following URL in a Java compatible web browser:

http:// hostname/Deja.html

where hostname is the hostname of the machine running the Sun Directory
Services and the web server.

Deja is displayed.

Displaying Deja Remotely Through Any Web
Server
1. Create a symbolic link from the documentation root directory for your web

server to /opt/SUNWconn/html:

prompt% cd docroot_dir
prompt% ln -s /opt/SUNWconn/html sds

where docroot_dir is the documentation root directory for your web server.

The web server must be running on the same machine as the dsservd daemon.
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2. Open the following URL in a Java compatible web browser:

http:// hostname/sds/Deja.html

where hostname is the hostname of the machine running Sun Directory Services
and the web server.

Deja is displayed.

Displaying Deja Locally Without any Web Server
1. On the machine running the directory server daemon, dsservd , open the

following URL in a Java compatible web browser:

file:/opt/SUNWconn/html/Deja.html

Deja is displayed. It tries to connect to the directory server specified in the
Deja.html file. If it can’t connect, an error message is displayed.

Displaying Deja Locally as a Java Application
1. On the machine running the directory server daemon, dsservd , Set the

JAVA_HOMEenvironment variable to the installation directory of your Java
Virtual Machine (JVM).

2. Type:

prompt% /opt/SUNWconn/bin/deja [ host_name [ port_number]]

where:

host_name is the hostname of the directory server. The default is localhost.

port_number is the port number of the directory server. The default is 389.

The client machine needs to have a Java Virtual Machine and JDK version 1.1.5 or
a compatible version installed.

Logging In
Directory access rights are defined by a set of access control rules on the directory
server. You must be the directory administrator to modify the access control rules.
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When you login to the directory, your username and password is compared with
those stored in the directory. If there is a match, the access rights defined in the
access control rules are granted.

You must have write permission before you can modify the directory contents. You
can browse the directory content without logging in. Figure 2–1 shows the Login
panel.

Note - It may be possible to browse the directory content without logging in. This
depends on the access control rules on the directory server.

Figure 2–1 Deja Login Panel

1. Click on the Login icon or select Login from the File menu.

2. Type the Distinguished Name (DN) of your entry in the User text field:

� If you are the directory administrator, type the administrator’s name, for
example admin .

� If there is an alias defined for you in the Deja.properties file on the
directory server, type the alias name. See “Adding a Login Alias” on page 65
for information on creating a login alias.

� If you cannot remember your DN, you can search for it in the directory:

a. Type the string that you want to search for in the User text field and click
the Search button in the login panel.
The search can include the wildcard character *.
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b. Double-click on your name in the Matching Usernames window.
The DN is transferred to the User text field.

3. Type your password in the Password field.

4. Click Login.

Deja checks to see if the Username you typed corresponds to an alias in the
Deja.properties file on the directory server. If an alias does not exist, Deja
checks to see if the Username you have typed is a valid DN. If it is not, Deja tries
to construct a DN from cn=Username and the first naming context it finds. If Deja
cannot construct a valid DN using any of these methods, it tries to login using
the Username you typed.

Your password is compared to the password stored in the directory. If there is no
match the login fails.

5. Select the desired profile (Standard, NIS or RADIUS) from the Profile option
button.

The default profile is Standard.

General Operations
Display Options
The Options menu is used to hide or show the toolbar, status bar, or directory
browser. The default view has all three display elements shown.

♦ Select an option from the Options menu to change its status.

Deja Properties Panel
The Deja Properties panel displays information about the selected user profile, and
the connection to the directory server. To access the Properties panel:

♦ Select Properties from the File menu.

The Properties panel is displayed, and shows the user properties and connection
properties of Deja. See Figure 2–2.
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Figure 2–2 Deja Properties Panel

User Properties

Name
If you are not logged into the directory server, Anonymous is displayed. If you have
logged in, the login name is displayed.

User Profile
To set the user profile:

♦ Select the profile (Standard, NIS or RADIUS) from the Profile option button in
the User Properties window.

The default profile is Standard.

Connection Properties

Server and Port Number
Deja displays information about its connection to the directory server. The default
port number that Deja uses to connect to the directory server is 389. The host name
and port number can be specified when Deja is started.
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� If Deja is viewed through a browser, the port number that Deja uses to connect to
the directory server is specified in the Deja.html file on the directory server. If it
is viewed as a local applet the hostname of the directory server is also taken from
the Deja.html file. If it is viewed as a remote applet Deja connects to the remote
host. See “Starting Deja” on page 7.

� If Deja is displayed as an application on the directory server, the hostname and
port number can be specified on the command line. See “Displaying Deja Locally
as a Java Application” on page 9.

To connect to a different directory server, or change the port number, from within
Deja see “Connecting to Another Directory Server” on page 14.

Opening and Closing Deja Windows

Opening a New Deja Window
♦ Select New Window from the File menu.

The new window has its own connection to the directory server.

Closing a Deja Window
♦ Select Close from the File menu to close the window.

The Deja window is closed.

Closing all Deja Windows
♦ Select Exit from the File menu.

A confirmation window is displayed. Click Yes to close all Deja windows.

Reconnecting Deja to the Directory Server
If the directory server is disabled for some reason, Deja loses its connection to the
directory. Deja does not automatically reconnect to the directory server when it is
re-enabled. To reconnect Deja to the directory server:

♦ Select Connect from the File menu.

Deja is reconnected.
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Connecting to Another Directory Server
To connect to a different directory server from within Deja:

1. Select Connect To... from the File menu.

The Connect To... dialogue box is displayed. See Figure 2–3.

Figure 2–3 Deja Connect To... Dialogue Box

2. Type the server name and port number in the Connect To... dialog box.

Deja tries to connect to the new directory server. If it is unable to connect, an
error message is displayed.

Note - If Deja is running as an applet through a browser, the ability to connect to
another server depends on the security level set by the browser.

Refreshing the Browser Window
If directory operations are being performed on the same directory server by another
user or the administrator, the browser window is not automatically updated. To
refresh the browser window:

1. In the browser window, click on the root entry of the branch you want to
refresh.

You can choose to refresh all of the directory by selecting the directory root entry,
or to refresh just a branch by clicking on the root entry of the branch.

2. Select Refresh Subtree from the File menu.

All the branches of the directory below the selected entry are collapsed in the
browser window. When they are reopened, they are refreshed.
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Creating a New Entry
Use Create to add new entries to the directory. Figure 2–4 shows the Deja Create
panel. You must have write permission for the parent to which you want to add an
entry. See “Logging In” on page 9 for information. To create a root entry for an
empty directory, see “Creating a Root Entry” on page 19.

Figure 2–4 Deja Create Panel

1. Click on the Create icon or select Create from the Entry menu.

The Create panel is displayed.

There are three steps to creating a directory entry. You must complete each step
before you can progress to the next one.

� Name the entry. See “Naming an Entry” on page 16.

� Select object classes for the new entry. See “Selecting Object Classes” on page
16.

� Add values to the mandatory and optional attributes for each objectclass. See
“Selecting Attributes” on page 17.

2. When you have completed the entry, click Done.
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Naming an Entry
For example, we will add an entry for the person John Smith, working in an
organization called XYZ based in the United States. You must have write permission
for the parent to which you want to add an entry. See “Logging In” on page 9 for
information.

1. Specify the parent of the entry:

a. Type the Distinguished Name (DN) of the Entry’s parent in the Parent text
field.
For the example, the DN for the entry’s parent is o=XYZ,c=US.

b. Alternatively, click once on the parent in the browser window to select it,
and click the Get from Browser button.
The Distinguished Name of the selected entry is imported to the Parent text
field.

2. Select the naming attribute from the option button.

Options depend on the directory schema. For the example, the naming attribute is
cn, which stands for common name.

3. Type the Relative Distinguished Name (RDN) of the entry in the Entry Name
text field.

For the example the RDN is cn=John Smith.

4. When you are satisfied with the entry name and parent, click the Next Step
button to select object classes.

The Select Objectclasses panel is displayed. The DN of the new entry is also
displayed. For the example the DN is cn=John Smith,o=XYZ,c=US.

Selecting Object Classes
You can define one or more object classes for your entry. When the selected
objectclasses list is complete, click the Next Step button to select attributes.

Note - If the selected objectclasses do not contain the previously selected naming
attribute, a warning message is displayed. You must either specify a different naming
attribute by going back to the first step, or add an appropriate object class to the entry.
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Adding an Object Class to the Entry
♦ Double click on the object class from the Available Objectclasses list to add the

object class to the entry

Or, select an object class from the Available Objectclasses list and click on the
right arrow button to add the object class to the entry.

For the example John Smith entry, add the person object class to the entry. Click the
Next Button to assign attributes to the entry.

Removing an Object Class From the Entry
♦ Double click on the object class in the Selected Objectclasses list to remove the

object class from the entry

Or, select the object class in the Selected Objectclasses list and click on the left
arrow button to remove the object class from the entry.

Selecting Attributes
Each object class you have selected has a number of mandatory and optional
attributes associated with it. Mandatory attributes are marked with (M), optional
attributes with (O). To complete the entry, you must provide values for the
mandatory attributes. The names of the mandatory attributes are already listed in the
entry definition.

Note - Deja produces an error message if you try to add an entry to the directory
without naming all the mandatory attributes.

For the example entry, the mandatory attributes are cn and sn (common name and
surname). Optional attributes for the person object class can include description, see
also, telephone number and userpassword.

Some attributes accept multiple values, others can only have one value. This is
defined in the schema by the SINGLE-VALUE keyword. If you try to add more than
one value to a single-valued attribute, an error message is displayed.

Assigning a Value to an Attribute
1. From the Choose Attribute list, or from the entry definition, select the attribute

for which you want to add a value.

For the example, select sn from the Choose Attribute list.

2. Type the value for the attribute in the text field.
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Type Smith in the text field.

3. Click Add to add the value of the attribute to the entry definition.

The value appears in the entry definition next to the attribute.

John Smith’s entry is now functionally complete, all of the mandatory attributes have
been named. However, we will add a couple of optional attributes to make the entry
more useful in the directory; telephone number and userpassword. Add the value 123
456 789 for the telephonenumber attribute, and add a user password for the entry.
Note that the value for the userpassword attribute is hidden in the entry definition.

To add an additional value for an attribute, repeat steps 1 to 3.

Finally, to complete the entry we will add a second value for the telephonenumber
attribute, John Smith’s internal extension number — 789. When you have added the
additional value, click on Done to add the entry to the directory. Double click on the
entry in the browser to display all of its attributes. See Figure 2–5.

Figure 2–5 Example Entry View Window

When an attribute has more than one value, an arrow is displayed next to the
attribute name in the entry definition. Click on the arrow to collapse or expand the
attribute definition. See “The View Window” on page 30 for more information.

Deleting a Value From an Attribute
1. Select the value or the attribute name in the entry definition.

2. Click Delete.

� If you delete the only value for an optional attribute, the attribute is removed
from the entry definition.
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� If you delete the only value for a mandatory attribute, the value is cleared from
the entry definition. The attribute stays in the definition.

Modifying an Attribute Value
1. Select the value of the attribute you want to modify in the entry definition.

The attribute value appears in the text field.

2. Modify the value and click Modify.

The modified value appears in the entry definition.

Cancel
♦ To cancel a create operation at any time, click Cancel.

The entry definition is cleared from the Create panel.

Creating a Root Entry
When you are connected to the directory server, the topmost entry in the directory
browser window is the Directory Specific Entry (DSE). It is displayed as:

ldap:// hostname: port

where hostname is the hostname of the directory server, and port is the port number
that Deja has used to connect to the directory server.

If there is no root entry listed below this when you start Deja, you will see an error
message that tells you that the database is empty. Before you can add entries to the
directory you must create a root entry for the database.

1. Login as administrator for the directory.

See “Logging In” on page 9.

2. Double click on the Directory Specific Entry in the browser window.

A view panel is displayed showing the attributes of the DSE. This window lists
the naming contexts defined for the directory server. See Figure 2–6.
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Figure 2–6 Naming Contexts for the Default Directory Specific Entry

You can create a root entry for each naming context defined for the server. By
default there are two naming contexts, o=xyz,c=us and dc=xyz,dc=us. To define
new naming contexts, see the Sun Directory Services 3.1 Administration Guide.

3. Click on the Create icon or select Create Entry from the Entry menu.

The Create panel is displayed.

4. In the Parent text field, type the Distinguished Name of the naming context for
which you want to create a root entry.

For example, to add a root entry for the naming context o=xyz,c=us, type
o=xyz,c=us in the Parent text field.

5. Click on Next Step.

Now you must select object classes and assign values to attributes using the same
procedure as for any new entry. See “Creating a New Entry” on page 15.

Deleting an Entry
The delete panel of Deja is used to delete entries from the directory. Figure 2–7
shows the Deja Delete panel.
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Figure 2–7 Deja Delete Panel

You must have write permission for the entry you want to delete. See “Logging In”
on page 9 for information.

1. Select the entry you want to delete in the browser window.

You can only delete leaf entries. You cannot delete a root entry or a parent that
still has children.

2. Click on the Delete icon, or select Delete from the Entry menu.

The Delete panel is displayed.

3. Click on Delete to remove the entry from the directory.

Click on Cancel to clear the delete panel.

Caution - There is no undelete function.
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Cut, Copy and Paste
Cutting an Entry
Use Cut to remove an entry from the directory and keep a copy of it on the clipboard.
The entry can be pasted from the clipboard into the directory in another location.

You must have write permission for the entry you want to cut. See “Logging In” on
page 9 for information.

1. In the browser, click on the entry you want to cut.

2. Click on the Cut icon, or select Cut from the Edit menu, or press Ctrl–x on the
keyboard.

The entry is cut from the directory to the clipboard.

3. You can now paste the entry to a new directory position.

4. If you want to restore the entry to the directory, select Restore from the Edit
menu.

The entry is restored to its original position in the directory if possible. If the
parent entry no longer exists, or has been renamed, the paste is not possible and
an error message is displayed.

Copying an Entry
Use Copy to copy an existing entry from the directory into the clipboard. The entry
can then be pasted from the clipboard into the directory in another location.

1. In the browser, click on the entry you want to copy to select it.

2. Click on the Copy icon, or select Copy from the Edit menu, or press Ctrl–c on
the keyboard.

The entry is copied from the directory to the clipboard.

3. You can now paste the entry to a new directory position.

Pasting an Entry
After a Cut or Copy operation, use Paste to paste an entry from the clipboard into
the directory. You can paste as a child or as a sibling of the selected entry. You must
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have write permission to paste an entry into the directory. See “Logging In” on page
9 for information.

♦ After a cut or a copy operation, click on the Paste icon, or select Paste from the
Edit menu, or press Ctrl–v on the keyboard.

If you selected a new entry before pasting, the pasted entry appears as a child of
the selected entry.

If you did not select a new entry before pasting, the pasted entry appears as the
last sibling of the selected entry.

If an entry already exists with the same name as the pasted entry, the new entry
is pasted with a number appended to its name.

Pasting an Entry to the Create Panel
After a Cut or Copy operation, you can choose to paste an entry directly to the Create
panel. This speeds up the process of creating a number of new, but similar entries.

Pasting an entry to the Create panel works in one of two ways:

� The paste action removes information from the Create panel before pasting the
entry

� The paste action does not clear data from the Create panel before pasting. This is
useful when you want to create an entry that contains the combined characteristics
of two or more entries.

The paste method is specified in the Deja.properties file on the directory server.
By default, Deja does not clear data from the Create panel before pasting. See
“Standard Create Parameters” on page 67 for information on changing the default
paste method.

1. After a cut or a copy operation, click on the Create icon, or select Create from
the Entry menu.

2. Select Paste to Create Panel from the Edit menu.

If you are in the first section of the Create panel, the entire entry is pasted into
the panel, including the name and naming attribute.

If you are in the Select Object Classes section of the Create Panel (you have
already named and selected a naming attribute for the entry) only the object
classes and attributes are pasted into the Create panel.

If you are in the Attributes section of the Create panel (you have already named
and selected a naming attribute for the entry, and have selected object classes for
the entry) only the attributes are pasted into the Create panel.

If you have selected a naming attribute and named your entry, and the pasted
objectclasses do not contain the selected naming attribute, you get an error
message. You must either change the naming attribute by going back to the first
step, or select an object class that contains the pasted naming attribute.
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3. Click Done when the entry is complete to add it to the directory.

Restoring an Entry
If you accidentally cut an entry from the directory, you can restore it, provided that
you have not performed any subsequent cut or copy operations.

♦ Select Restore from the Edit menu.

The entry on the clipboard is returned to its original location.

Modifying an Entry
Use Modify to change attributes and object classes in directory entries. Figure 2–8
shows the Deja Modify panel.

Figure 2–8 Deja Modify Panel

You must have write permission for the entry you want to modify. See “Logging In”
on page 9 for information.

1. In the browser, click on the entry you want to modify.

2. Click on the Modify icon or select Modify from the Entry menu.
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The Modify Attributes window is displayed. Click on the Modify Objectclasses
button to display the Modify Objectclasses window.

You can modify the following characteristics of an entry:

� The values for the mandatory and optional attributes for each object class. See
“Selecting Attributes” on page 17.

� The object classes for the entry. See “Selecting Object Classes” on page 16.

If you want to change the name of the entry, use the Rename function. See
“Renaming an Entry” on page 25.

3. When you have finished the modifications, click Done.

Renaming an Entry
Use Rename to modify the Relative Distinguished Name (RDN) of an entry. Figure
2–9 shows the Deja Rename panel.

Figure 2–9 Deja Rename Panel

You must have write permission for the entry you want to rename. See “Logging In”
on page 9 for information.

1. Select the entry you want to rename in the browser window.
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You can only rename leaf entries. You cannot rename parents that still have
children, or the root entry.

2. Click on the Rename icon, or select Rename from the Entry menu.

The rename panel appears. The name of the parent and the Relative
Distinguished Name (RDN) of the selected entry are displayed.

3. Type the new RDN of the entry in the To text field.

4. If you want the new RDN to replace the old RDN, check the Remove old RDN
check box.

By default the new RDN replaces the old RDN. If the Remove old RDN check
box is unchecked, the new RDN is added to the entry as an additional value.

5. Click the Rename button.

Searching for an Entry
Use Search when you want to find an entry in the directory. This function provides
search facilities based on up to three criteria. Figure 2–10 shows the Deja Search
panel. The available search types are defined in the Deja.properties file on the
directory server. For information on modifying the default searches see “Standard
Search Parameters” on page 65. For information on adding a new search see
“Adding a New Standard Search” on page 66.
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Figure 2–10 Deja Search Panel

1. Click on the Search icon, or select Search from the Entry menu.

The Search panel is displayed.

2. Select the type of entry you want to search for using the Person option button.

The options in the Person option button are defined in the Deja.properties
file on the directory server. See “Standard Search Parameters” on page 65 for
information on defining standard searches.

Default options are:

� Person

� Organization

� Locality

� Specify Filter

See “Search Filters” on page 28.

3. Type the text string or filter you want to search for in the search text field.

The search can include the wildcard character *.

4. Click Search to start the search.

The search results are displayed in the search results list and the number of
entries found is displayed in the status bar. If there are no matches, the search
results list is empty and the status bar indicates that no entries were found.

You can refine your search in two ways:

� Combine two or more searches. See “Combining Searches” on page 28.
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� Constrain the search. See “Using Search Contraints” on page 29.

5. To stop the search at any time, click the Stop button.

The search is stopped and no results are returned.

6. Click the Clear button to clear the search text field.

Search Filters
Using a search filter is a way of specifying a set of entries, based on the presence of a
particular attribute or attribute value. You can combine and or or logical operators in
the same search. Use & for and and | for or. Table 2–1 gives some examples of filters.

TABLE 2–1 Search Filter Examples

Filter Definition

l=London locality is “London”

cn=*Rob* common name contains
“Rob”

(&(cn=Ch*)(cn=*Thomas*)) comman name starts with
“Ch” and contains “Thomas”

(|(sn=*bert*)(sn=*bort*)) surname contains “bert” or
“bort”

(&(cn=Rob*)(|(cn=*Green*)(cn=*Jones*)) common name starts with
“Rob” and contains “Green”
or “Jones”

Combining Searches
You can combine your first search string with up to two other text strings using and
or or logical operators. You cannot combine both operators in the same search. For
example, you can search for cn=*Robert* and l=Boston and o=xyz, or you can search
for cn=*Robert* or l=Boston or o=xyz.

1. Select the type of entry you want to search for using the Person option button.

2. Type the text string you want to search for in the search text field.
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3. Click on the And or Or buttons to select the logical operator.

4. Select the entry type for the second text string using the Person option button.

5. Type the second text string in the search text field.

6. If you want to add a third search criterion, click the And or Or button.

7. To remove a search criterion, click the Back button.

8. Click the Clear button to clear all the search text fields.

Using Search Contraints
If you do not set all of the search constraints, the default values are used.

1. Type the Distinguished Name (DN) of the root of the subtree you want to
search.

Or, select the root of the subtree you want to search in the browser window and
click Get from Browser.

2. Select the search time limit (in ms) from the Time Limit option button.

By default, there is no time limit.

3. Select the maximum number of search results from the Max. Matches option
button.

The default maximum number of search matches is 100.

4. Select the scope of the search from the Search Scope option button.

� One Level searches the entries on the level immediately below the search root.

� Subtree searches all entries below the search root.

The default scope is subtree.

5. If you want to dereference aliases as you search, check the Dereference Aliases
check box.

If you choose to dereference aliases as you search, the distinguished name (DN)
of an alias entry is translated to the DN of the actual entry. With the dereferencing
flag checked, the object referred to by the alias is returned by a search. With the
dereferencing flag unchecked, the alias entry is returned by a search.
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Search Results List
Search results are displayed in the list below the search criteria.

The RDN, common name, telephone number and email address for each match are
displayed.

♦ To view an entry, double-click on the entry’s name in the search results list.

The view entry window is displayed.

Viewing an Entry
Use View to look at the attributes defined for an entry in the directory. Figure 2–11
shows Deja View window. You can only open one View window per entry. To refresh
a View window after modifying an entry, View the entry again. The original View
window is replaced with a new one.

Figure 2–11 Deja View Window

The View Window
There are three ways to display the View window:

� Double-click on an entry in the browser window

� Select an entry in the browser window and click on the View icon, or select View
from the Entry menu

� Click on an entry in the search results list

The view window shows the list of attributes and values associated with the selected
entry. Each attribute has an icon by the side of it:

30 Sun Directory Services 3.1 User’s Guide ♦ June 1998



The attribute has one value. It is also used in the Create or
Modify panels when a mandatory attribute has no value.

The attribute has more than one value, but only the first is
displayed. Click on the arrow to see the other values.

The attribute has more than one value and they are all
displayed. Click on the arrow to hide all but the first value.

Closing a View Window
♦ Select Close from the Window menu of the View window, or Double click on

the Window menu button.

The View window closes.

Copying an Entry From a View Window
♦ Select Copy from the Edit menu of the View Window.

The entry is copied to the clipboard.

Highlighting an Entry From a View Window
♦ Select Highlight from the Edit menu of the View Window.

The entry is highlighted in Deja’s browser window.
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CHAPTER 3

Deja — Operations on NIS Entries

This chapter describes the NIS-specific search and create panels. All other Deja
functions are described in Chapter 2.

To view the NIS-specific search and create panels you must change the Deja user
profile to NIS. See “User Profile” on page 12 for information.

The Deja.properties file on the directory server defines the NIS maps available
in Deja. For information on adding or modifying NIS maps see “NIS Parameters” on
page 68.

Note - The NIS maps are defined in the nis.mapping file on the directory server. If
the nis.mapping file has been changed, the changes should be copied into the
Deja.properties file using the dejasync utility. See Appendix B for information.

Creating a New Entry
Use Create to add new entries to the NIS directory. Figure 3–1 shows the Deja Create
panel for NIS users.

33



Figure 3–1 Deja Create Panel for NIS Users

1. Click on the Create icon or select Create from the Entry menu.

The Create panel is displayed.

There are three steps to creating a NIS directory entry. You must complete each
step before you can progress to the next one. Click on Next Step and Previous
Step to navigate between the steps.

� Name the entry. See “Naming an Entry” on page 34.

� Select object classes for the new entry. See “Selecting Object Classes” on page
16.

� Add values to the mandatory and optional attributes for each object class. See
“Selecting Attributes” on page 17.

2. When you have completed the entry, click Done.

Naming an Entry
1. Select the name of the map to which the new entry should be added from the

Map Name option button.

The default options are Users, Aliases, Hosts and Groups.

Note - To modify the default NIS maps, or create new NIS maps, change the
definitions in the Deja.properties file on the directory server. See “NIS
Parameters” on page 68 for information.
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2. The default parent name is automatically added into the Parent text field. To
select another parent name, type the Distinguished Name of the Entry’s parent
in the Parent text field or click once on the parent in the browser window to
select it and click the Get From Browser button next to the Parent text field.

The Distinguished Name of the selected entry is imported to the Parent text field.

The default parent name depends on the selected map, and is defined in the
Deja.properties file on the directory server. See “NIS Parameters” on page
68 for information.

3. Select the naming attribute with the option button.

The list of naming attributes is defined in the Deja.properties file on the
directory server. See “NIS Parameters” on page 68 for information.

4. Type the Relative Distinguished Name of the entry in the Entry Name text field.

5. When you are satisfied with the entry name and parent, click the Next Step
button to select object classes and attributes.

See “Selecting Object Classes” on page 16 for information on selecting object
classes. The Select Object Classes window is displayed pre-filled with default
object classes depending on the selected map. The default object classes are
specified in the Deja.properties file on the directory server. See “NIS
Parameters” on page 68 for information.

See “Selecting Attributes” on page 17 for information on selecting attributes for
the entry.

Cancel
♦ To cancel a create operation at any time, click Cancel.

The entry definition is cleared from the Create panel.

Searching for an Entry
Use Search when you want to find a NIS entry in the directory. By default you can
search four NIS maps with this function; users, aliases, hosts and groups. Figure 3–2
shows the Deja Search panel for NIS users.

The Deja.properties file on the directory server defines the NIS maps available
in Deja. For information on adding or modifying NIS maps see “NIS Parameters” on
page 68.
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Figure 3–2 Deja Search Panel for NIS Users

Searching for a NIS Entry
1. Click on the Search icon, or select Search from the Entry menu.

The Search panel is displayed.

2. Select the map you want to search from the Map Name option button.

Default options are Users, Aliases, Hosts or Groups.

Note - To modify the default NIS maps, or create new NIS maps, change the
definitions in the Deja.properties file on the directory server. See “NIS
Parameters” on page 68 for information.

3. Type the text string you want to search for in the NIS Key text field.

The search can include the wildcard character *.

4. Click Search to start the search.

The search results are displayed in the search results list and the number of
entries found is displayed in the status bar. If there are no matches, the search
results list is empty and the status bar indicates that no entries were found.

36 Sun Directory Services 3.1 User’s Guide ♦ June 1998



5. To stop the search at any time, click the Stop button.

The search is stopped and no results are returned.

6. Click the Clear button to clear the search text field.

Search Results List
Search results are displayed in a list below the search criteria.

The headings of the search results table depend on the map being searched:

MapName Attributes

users cn, uid, uidNumber, gidNumber, homeDirectory

aliases cn, rfc822mailMember

hosts cn, ipHostNumber, macaddress

groups cn, gidNumber, memberUid

♦ To view an entry from the search results list, double-click on the entry’s name.

The view entry window is displayed, and the entry is highlighted in the browser
window.
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CHAPTER 4

Deja — Operations on RADIUS Entries

This chapter describes the RADIUS-specific search, create and modify panels. All
other Deja functions are described in Chapter 2.

To view the RADIUS-specific search, create and modify panels you must change the
Deja user profile to RADIUS. See “User Profile” on page 12 for information.

The Deja.properties file on the directory server defines the RADIUS user profiles
available in Deja. For information on adding or modifying RADIUS user profiles see
“RADIUS Parameters” on page 72.

Note - The RADIUS profiles are defined in the radius.mapping file on the
directory server. If the radius.mapping file has been changed, the changes should
be copied into the Deja.properties file using the dejasync utility. See Appendix
B for information.

Creating a New Entry
Use Create to add new entries to the RADIUS directory. Figure 4–1 shows the Deja
Create panel for RADIUS users.
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Figure 4–1 Deja Create Panel for RADIUS Users

1. Click on the Create icon or select Create Entry from the Entry menu.

The Create panel is displayed.

There are two steps to creating a RADIUS directory entry. You must complete
each step before you can progress to the next one. Click on Next Step and
Previous Step to navigate between the steps.

� Name the entry. See “Naming an Entry” on page 40.

� Assign attributes to the entry and name them. See “Selecting Attributes” on
page 17.

2. When you have completed the entry, click Done.

Naming an Entry
1. Select the type of entry you want to add (Remote User or Remote Access

Server).

2. If you are adding a Remote User, specify the profile of the new entry
(Standard, PPP, SLIP, LOGIN).

Note - The list of RADIUS profiles available in Deja is defined in the
Deja.properties file on the directory server. See “RADIUS Profiles” on page
75 for information on defining RADIUS user profiles.
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3. Specify the parent of the entry:

By default, the Parent text field holds the distinguished name of an entry
specified in the Deja.properties file on the directory server. To select another
parent entry:

� Type the Distinguished Name of the Entry’s parent in the Parent text field

� Alternatively, click once on the parent in the browser window to select it and
click the Get From Browser button next to the Parent text field.

The Distinguished Name of the selected entry is imported into the Parent text
field.

4. Select the naming attribute for the entry with the option button.

The list of available naming attributes is defined in the Deja.properties file
on the directory server. See “RADIUS General Parameters” on page 77 for
information on defining the list of available naming attributes.

5. Type the value for the naming attribute for the entry in the Entry Name text
field.

6. When you are satisfied with the entry name and parent, click the Next Step
button to assign values to the attributes.

See “Selecting Attributes” on page 17 for information on selecting attributes for
the entry.

Check Data and Reply Data Attributes
The RADIUS add attributes window features four additional buttons:

� Chk Add — Select an attribute and type a value for it in the text window. If you
click the Chk Add button, the value is added to the entry definition, and the name
of the attribute is added to the Radius Check Data optional attribute which
matches the grpCheckInfo in the radius.mapping file.

For example, if you select the User ID attribute from the Choose Attribute list and
type the value charles in the text window, when you click on Chk Add, the
value charles is added to the User ID attribute, and uid is added to the Radius
Check Data attribute.

� Rpl Add — Select an attribute and type a value for it in the text window. If you
click the Rpl Add button, the value is added to the entry definition, and the name
of the attribute is added to the Radius Reply Data optional attribute which
matches the grpReplyInfo in the radius.mapping file.

� Chk Del — Select the value of the attribute you want to delete from the entry
definition. If you click the Chk Del button, the value is removed from the entry
definition, and the name of the attribute is removed from the Radius Check Data
optional attribute which matches the grpCheckInfo in the radius.mapping file.
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� Rpl Del — Select the value of the attribute you want to delete from the entry
definition. If you click the Rpl Del button, the value is removed from the entry
definition, and the name of the attribute is removed from the Radius Check Data
optional attribute which matches the grpReplyInfo in the radius.mapping file.

The grpCheckInfo attribute, contains a list of attributes that must be checked by the
RADIUS server against the information supplied by the remote user. If the
grpCheckInfo attribute is not present, or if it does not contain any attributes, then all
the attributes in the remote user’s entry are checked before access is granted to the
user.

The grpReplyInfo attribute, contains a list of attributes returned by the RADIUS
server with an access-accept or access-reject response. It can contain connection
parameters such as a PPP or SLIP profile.

Cancel
♦ To cancel a create operation at any time, click Cancel.

The entry definition is cleared from the Create panel.

Modifying an Entry
Use Modify to change attributes and object classes in RADIUS directory entries.
Figure 4–2 shows the Deja Modify panel for RADIUS users.
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Figure 4–2 Deja Modify Panel for RADIUS Users

You must have write permission for the entry you want to modify. See “Logging In”
on page 9 for information.

1. In the browser, click on the entry you want to modify.

2. Click on the Modify icon or select Modify from the Entry menu.

The Modify Attributes window is displayed.

See “Selecting Attributes” on page 17 for information on modifying attributes for
the entry.

If you want to change the name of the entry, use the Rename function. See
“Renaming an Entry” on page 25.

The RADIUS modify attributes window features four additional buttons: Chk
Add, Rpl Add, Chk Del, and Rpl Del. see “Check Data and Reply Data
Attributes” on page 41 for details.

3. When you have finished your modifications click Done.

Reset
♦ To cancel a modify operation at any time, click Reset.

The entry definition is cleared from the Modify panel.
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Searching for an Entry
Use Search when you want to find a RADIUS entry in the directory. This function
provides search facilities for up to three criteria. Figure 4–3 shows the Deja Search
panel for RADIUS users.

Figure 4–3 Deja Search Panel for RADIUS Users

♦ Click on the Search icon, or select Search from the Entry menu.

The Search panel is displayed.

Note - The types of searches available, and the categories of search results are
defined in the Deja.properties file on the directory server. See “RADIUS Search
Panel Definitions” on page 72 for information on defining searches.

The default search types are:

� Remote User search — See “Remote User Searches” on page 45.

� Remote Access Server (RAS) search — See “Remote Access Server Search” on page
49.

� Complex Searches — See “Complex Searches” on page 51.
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You can combine Remote User searches with Remote Access Server searches using
and or or operators. You cannot combine both operators in the same search. Up to
three search criteria can be defined.

Remote User Searches
There are seven searches pre-defined for remote user entries:

� Search by login name — where Deja searches for entries that have the remoteuser
objectclass, and whose user id matches the text field. See “Using the Remote User
Login Name Search” on page 45.

� Search by user name — where Deja searches for entries that have the remoteuser
objectclass, and whose user name matches the text field. See “Using the Remote
User User Name Search” on page 46.

� List blocked accounts — where Deja searches for entries that have the remoteuser
object class, and that have one or more failed authorization accesses. See “Using
the Remote User Blocked Accounts Search” on page 46.

� List PPP users — where Deja searches for entries that have the remoteuser object
class, that have a PPP profile, and have a PPP password set. See “Using the
Remote User List PPP Users Search” on page 47.

� List SLIP users — where Deja searches for entries that have the remoteuser object
class, that have a SLIP profile, and have a SLIP password set. See “Using the
Remote User List SLIP Users Search” on page 48.

� List LOGIN users — where Deja searches for entries that have the remoteuser
object class, that have a LOGIN profile, and have a LOGIN password set. See
“Using the Remote User List LOGIN Users Search” on page 48.

� Search by name and mail — where Deja searches for entries that have the
remoteuser object class, and whose name and email address match the text fields.
See “Using the Remote User Name and Mail Search” on page 49.

To define a new type of search, see “RADIUS Search Panel Definitions” on page 72.

The default search root for remote user searches is o=xyz_remote_users,c=us. This is
defined in the Deja.properties file on the directory server and cannot be changed
from within Deja. See “RADIUS General Parameters” on page 77 for information.

Using the Remote User Login Name Search
1. Select Remote User from the Type of Search option button.

2. Select Search by Login Name from the Defined Searches option button.

3. Type the User ID of the entry you want to find in the search text field.
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The search can include the wildcard character *.

4. Click Search to start the search.

The search results are displayed in the search results list and the number of
entries found is displayed in the status bar. If there are no matches, the search
results list is empty and the status bar indicates that no entries were found.

You can refine your search by combining it with RAS object class searches or
further remote user object class searches. See “Complex Searches” on page 51.

5. To stop the search at any time, click the Stop button.

The search is stopped and no results are returned.

6. Click the Clear button to clear the search text field.

Using the Remote User User Name Search

1. Select Remote User from the Type of Search option button.

2. Select Search by User Name from the Defined Searches option button.

3. Type the user name of the entry you want to find in the search text field.

The search can include the wildcard character *.

4. Click Search to start the search.

The search results are displayed in the search results list and the number of
entries found is displayed in the status bar. If there are no matches, the search
results list is empty and the status bar indicates that no entries were found.

You can refine your search by combining it with RAS object class searches or
further remote user object class searches. See “Complex Searches” on page 51.

5. To stop the search at any time, click the Stop button.

The search is stopped and no results are returned.

6. Click the Clear button to clear the search text field.

Using the Remote User Blocked Accounts Search

1. Select Remote User from the Type of Search option button.

2. Select List Blocked Accounts from the Defined Searches option button.

There are no user input fields for this search. Deja searches for entries with the
following parameters:
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objectclass = remoteuser
radiusAuthFailedAccess ≥ RADIUS_MAX_FAIL

where RADIUS_MAX_FAIL is defined in the Deja.properties file on the
directory server. The default value for RADIUS_MAX_FAIL is 4. See “RADIUS
General Parameters” on page 77 for information.

3. Click Search to start the search.

The search results are displayed in the search results list and the number of
entries found is displayed in the status bar. If there are no matches, the search
results list is empty and the status bar indicates that no entries were found.

You can refine your search by combining it with RAS object class searches or
further remoteuser object class searches. See “Complex Searches” on page 51.

4. To stop the search at any time, click the Stop button.

The search is stopped and no results are returned.

Using the Remote User List PPP Users Search

1. Select Remote User from the Type of Search option button.

2. Select List PPP Users from the Defined Searches option button.

There are no user input fields for this search. Deja searches for entries with the
following parameters:

objectclass = remoteuser
radiusPppProfile = *
radiusPppPasswd = *

3. Click Search to start the search.

The search results are displayed in the search results list and the number of
entries found is displayed in the status bar. If there are no matches, the search
results list is empty and the status bar indicates that no entries were found.

You can refine your search by combining it with RAS object class searches or
further remoteuser object class searches. See “Complex Searches” on page 51.

4. To stop the search at any time, click the Stop button.

The search is stopped and no results are returned.
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Using the Remote User List SLIP Users Search

1. Select Remote User from the Type of Search option button.

2. Select List SLIP Users from the Defined Searches option button.

There are no user input fields for this search. Deja searches for entries with the
following parameters:

objectclass = remoteuser
radiusSlipProfile = *
radiusSlipPasswd = *

3. Click Search to start the search.

The search results are displayed in the search results list and the number of
entries found is displayed in the status bar. If there are no matches, the search
results list is empty and the status bar indicates that no entries were found.

You can refine your search by combining it with RAS object class searches or
further remoteuser object class searches. See “Complex Searches” on page 51.

4. To stop the search at any time, click the Stop button.

The search is stopped and no results are returned.

Using the Remote User List LOGIN Users Search

1. Select Remote User from the Type of Search option button.

2. Select List LOGIN Users from the Defined Searches option button.

There are no user input fields for this search. Deja searches for entries with the
following parameters:

objectclass = remoteuser
radiusLoginProfile = *
radiusLoginPasswd = *

3. Click Search to start the search.

The search results are displayed in the search results list and the number of
entries found is displayed in the status bar. If there are no matches, the search
results list is empty and the status bar indicates that no entries were found.
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You can refine your search by combining it with RAS object class searches or
further remoteuser object class searches. See “Complex Searches” on page 51.

4. To stop the search at any time, click the Stop button.

The search is stopped and no results are returned.

Using the Remote User Name and Mail Search
1. Select Remote User from the Type of Search option button.

2. Select Search by Name / Mail from the Defined Searches option button.

3. Type the username and email address of the entry you want to find in the
search text fields.

The search can include the wildcard character *.

4. Click Search to start the search.

The search results are displayed in the search results list and the number of
entries found is displayed in the status bar. If there are no matches, the search
results list is empty and the status bar indicates that no entries were found.

You can refine your search by combining it with RAS object class searches or
further remoteuser object class searches. See “Complex Searches” on page 51.

5. To stop the search at any time, click the Stop button.

The search is stopped and no results are returned.

6. Click the Clear button to clear the search text fields.

Remote Access Server Search
There are two searches pre-defined for RAS entries:

� Search by RAS Name — where Deja searches for all entries that have the
objectclass RAS, and whose RAS name matches the text field. See “Using the RAS
Name Search” on page 50.

� Search by RAS IP Address — where Deja searches for all entries that have the
objectclass RAS, and whose RAS network address matches the text field. See
“Using the RAS IP Address Search” on page 50.

To define a new type of search, see “RADIUS Search Panel Definitions” on page 72.

The default search root for remote access server searches is o=xyz_ras,c=us. This is
defined in the Deja.properties file on the directory server and cannot be changed
from within Deja. See “RADIUS General Parameters” on page 77 for information.
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Using the RAS Name Search
1. Select Remote Access Server from the Type of Search option button.

2. Select Search by RAS Name from the Defined Searches option button.

3. Type the name you want to find in the search text field.

The search can include the wildcard character *.

4. Click Search to start the search.

The search results are displayed in the search results list and the number of
entries found is displayed in the status bar. If there are no matches, the search
results list is empty and the status bar indicates that no entries were found.

You can refine your search by combining it with remote user object class searches
or further RAS object class searches. See “Complex Searches” on page 51.

5. To stop the search at any time, click the Stop button.

The search is stopped and no results are returned.

6. Click the Clear button to clear the search text fields.

Using the RAS IP Address Search
1. Select Remote Access Server from the Type of Search option button.

2. Select Search by RAS IP Address from the Defined Searches option button.

3. Type the IP address you want to find in the search text field.

4. Click Search to start the search.

The search results are displayed in the search results list and the number of
entries found is displayed in the status bar. If there are no matches, the search
results list is empty and the status bar indicates that no entries were found.

You can refine your search by combining it with remote user object class searches
or further RAS object class searches. See “Complex Searches” on page 51.

5. To stop the search at any time, click the Stop button.

The search is stopped and no results are returned.

6. Click the Clear button to clear the search text fields.
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Complex Searches
You can combine three types of search with the complex searches option:

� Remote User searches

� Remote Access Server searches

� Specify Filter — See “Search Filters” on page 28 for a description of acceptable
filters.

Searches can be combined with and or or operators. You cannot combine both
operators in the same search. Up to three search criteria can be defined.

1. Select Complex Searches from the Type of Search option button.

2. Select the first search criterion from the Remote User option button and type
the search string or filter definition in the text field.

3. Click on the And or Or buttons to select the logical operator.

4. Select the second search criterion from the Remote User option button and type
the search string or filter definition in the text field.

5. If you want to add a third search criterion, click the And or Or button again.

6. To remove a search criterion, click the Back button.

7. Type the Distinguished Name (DN) of the root of the tree you want to search,
or select the root you want to search in the browser window and click Get from
Browser.

8. Click Search to start the search.

The search results are displayed in the search results list and the number of
entries found is displayed in the status bar. If there are no matches, the search
results list is empty and the status bar indicates that no entries were found.

9. To stop the search at any time, click the Stop button.

The search is stopped and no results are returned.

10. Click the Clear button to clear all the search parameters.

Search Results List
Search results are displayed in a list below the search criteria.

The headings of the search results table depend on the search. The types of searches,
and the headings for search results are defined in the Deja.properties file on the
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directory server. All the headings can be modified except those for complex searches.
See “RADIUS Search Panel Definitions” on page 72 for information on defining
searches.

The attributes returned for the default searches are:

Search Type Attributes

remoteuser login name cn, uid, framedProtocol

remoteuser user name cn, uid

remoteuser blocked accounts cn, uid, radiusFailedAccess

remoteuser all PPP users cn, uid

remoteuser all SLIP users cn, uid

remoteuser all LOGIN users cn, uid

remoteuser user name/email address cn, uid

RAS name cn, iphostnumber

RAS IP Address cn, iphostnumber

Complex searches cn, iphostnumber, uid, radiusFailedAccess

♦ To view an entry from the search results list, double-click on the entry’s name.

The View window is displayed, and the entry is highlighted in the browser
window.
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CHAPTER 5

Browsing the Directory Through the
Web Gateway

The Web Gateway provides an interface to a Sun Directory Services directory from
any web browser. You can view the directory, search for and read entries, and
modify some directory information. This is useful for checking information in the
directory, but it is a general-purpose tool and should not be used in place of Deja.

The Web Gateway requires that the gateway daemon, dswebd , and the directory
services daemon, dsservd , are running on the server that holds the directory. If they
are not, start them as described in “Starting the dsservd and dswebd Daemons” on
page 6.

The Web Gateway is configured by modifying the configuration files on the directory
server. See the Sun Directory Services 3.1 Administration Guide for information.

Displaying the Web Gateway
From any machine, open the following URL is a web browser:

http:// server: webgwport/

Where server is the name of a directory server running the dsservd and dswebd
daemons and webgwport is the port used by dswebd . The default port is 1760.

The Root Directory Specific Entry page is displayed. See Figure 5–1.

It shows the root directory specific entry in the data store to which you are
connected. If the data store holds several naming contexts, several entries are listed,
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sorted by object class. By default there are two naming contexts defined, o=xyz,c=us
and dc=xyz,dc=us. Each entry is a hot link to a search facility that enables you to
browse the naming context.

Figure 5–1 Web Gateway Root Directory Specific Entry

Browsing the Directory
1. Click a hotlink for a naming context.

Your browser displays a search page, as shown in Figure 5–2.

The search page shows the root entry for the naming context; in Figure 5–2 this
entry is o=XYZ, c=US.
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Figure 5–2 Browsing the Directory

2. Specify the top of the subtree you want to browse.

Use the Move upwards control to move up the directory tree hierarchy. At each
position, the naming context list shows you the parent naming context and any
child naming contexts. Choose the naming context you want to browse. The top
entry in that naming context becomes the currently-selected entry.

3. Click on the Browse the Directory button.

The child entries of the currently-selected entry are listed. To see the contents of
any entry, click on the link for that entry.
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Searching the Directory
1. Specify the top of the subtree you want to browse.

Use the Move upwards control to move up the directory tree hierarchy. At each
position, the naming context list shows you the parent naming context and any
child naming contexts. Choose the naming context you want to browse. The top
entry in that naming context becomes the currently-selected entry.

2. Enter the search string in the Subtree search field and click on the Search
button.

The search string can be an attribute value, or a valid LDAP filter. See Table 2–1.

After a short delay, a list of entries that match the search string is displayed, up
to the limit configured for the gateway. See the Sun Directory Services 3.1
Administration Guide for information. Click on an entry to see the attributes it
contains.
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Figure 5–3 Search Results Page

By default, a search at the upper levels of the directory tree (root or country level)
is a one-level search, that is, only child entries of the currently selected entry is
searched and the target of the search is assumed to be a country, organization or
locality entry. In the rest of the directory tree, a search is a subtree search and the
target is assumed to be a entry relating to a person. This search strategy is
configured in the file dswebfilter.conf . See the dswebfilter.conf(4)
manpage for information.

Browsing the Directory Through the Web Gateway 57



Reading a Directory Entry
For any entry, you have the option of viewing all the attributes and their values. Use
the View All Attributes button to show all the attributes and values assigned to the
entry.

Some attributes are handled in a special way:

� An attribute’s value that is a distinguished name (DN) is a hotlink to the entry
identified by the DN.

� An attribute containing an email address is a hotlink to a mailer to send mail to
that address.

� An attribute containing an URL is a hotlink to the target of the URL.

� A photograph or other image is either displayed as an inline image or can be
downloaded by clicking on a hotlink. The display format depends on your
browser.

� Audio data is retrieved by clicking on a hotlink.

Modifying a Directory Entry
To modify an entry you must bind to the directory, supplying your distinguished
name and password. Not all attributes can be modified using the Web Gateway. To
modify an attribute of an entry:

1. Display the entry that you want to modify.

At the end of the attribute list there is a Modify Attributes button. Depending on
the configuration of your Web Gateway, there may also be buttons for modifying
specific attributes.

2. Click on the button for modifying the attribute you want to change, or click on
the Modify Attributes button.

If you are not logged in, an authentication request window is displayed. See
“Authentication” on page 59 for information. Enter your distinguished name and
password.

The access controls defined for the entry will determine whether you are
permitted to modify any attributes in the entry.

3. Supply a new value for the attribute you want to modify.

4. When you have finished modifying the entry, click the Apply button.
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Authentication
Login Button
The Login Button provides a means of logging in for the duration of your connection
to the directory. The login button grants the access rights specified in the access
control rules on the directory server. Click the Login button to display a login
request window. See Figure 5–4.

♦ Type your user name and password and click OK.

If there are more than one entry in the directory with the attribute uid matching
the user name, the login fails.

Figure 5–4 Login Request Window

♦ To logout, click the logout button.

The access priviledges are cleared.

Authentication Request Window
If you are not logged in, and you try to modify the directory contents, you will get
an authentication request. This authentication is for the current modify operation
only. You will have to authenticate for each subsequent modification. The bind DN is
supplied pre-filled.

♦ Type your password and click the Bind to Modify button.

The password is checked against the password stored in the directory. If the
access control rules deny you modification rights to the entry you are modifying,
the authentication fails. See Figure 5–5.
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Figure 5–5 Authentication Request Page
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APPENDIX A

The Deja.properties File

Many of Deja’s characteristics can be configured by the directory administrator. The
characteristics are defined in the /opt/SUNWconn/ldap/html/Deja.properties
file on the directory server. You must be authenticated as superuser or root to
modify the Deja.properties file. After making changes to the
Deja.properties file, close Deja and restart it for the changes to take effect.

File Structure
The Deja.properties file consists of four sections:

� General Parameters, see “General Parameters” on page 62.

� Standard LDAP parameters, see “Standard LDAP Parameters” on page 64.

� NIS parameters, see “NIS Parameters” on page 68.

� RADIUS parameters, see “RADIUS Parameters” on page 72.

In each section is a list of definitions, each of which is terminated with a carriage
return. Separate elements in a definition are separated by commas. Related elements
are separated by semi-colons.

For example, the code below defines the default attributes displayed for RADIUS
searches. The two attribute definitions are separated by a comma. Each definition
consists of an attribute whose value is to be displayed (cn and uid), and a label for
the results table header row (RADIUS_RU_CN_ATTR_LABELand
RADIUS_RU_UID_ATTR_LABEL) separated by a semi-colon. The list is terminated
with a carriage return.
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RADIUS_RU_LIST.default= cn;RADIUS_RU_CN_ATTR_LABEL,
uid;RADIUS_RU_UID_ATTR_LABEL

The character sequence {0} is used in the Deja.properties file to indicate user
input. The character sequence {0} is replaced by the text typed by the user. For
example, in a search filter, the definition (cn=*{0}*) specifies that the search will
result in entries for which cn contains the search string typed by the user in the text
field.

Labels
Standard Deja labels and identifiers (parameters ending in _LABEL, _IDENTIFIER
or _CHOICE) are defined in the localized resource bundle. You cannot change these
definitions. You can, however, create your own labels and replace the default ones.
For example, if you wanted to replace the Mail label in the Standard Search results
table with Email, substitute the word Email for
STANDARD_SEARCH_TABLE_MAIL_LABELin the
STANDARD_SEARCH_TABLE_LABELSdefinition. The definition now reads:

STANDARD_SEARCH_TABLE_LABELS=
cn; STANDARD_SEARCH_TABLE_NAME_LABEL,
telephoneNumber; STANDARD_SEARCH_TABLE_PHONE_LABEL,
mail; Email

General Parameters
In this section the following parameters are defined:

SCHEMA_THREAD_TIME_LIMIT

Defines a time limit in milliseconds on the time it takes Deja to read the schema.
The default value is no time limit.

REFERRALS_MANAGE_DSA

With this option set to true , entries with the object class referral are treated like
normal entries. With this option set to false , Deja returns a search reference
result. The default value is true .
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BROWSER_ENTRY_LIMIT

Specifies the maximum number of entries that can be displayed in the browser. If
a limit has been set, you must refresh some subtrees before opening more. The
default value is no limit.

BROWSER_SUBENTRY_LIMIT

Defines the maximum number of immediate children of an entry that can be
displayed in the browser. The default value is no limit.

BROWSER_LOAD_SUBNODES_TIME_LIMIT

Specifies the maximum amount of time allowed for Deja to load the children of a
node when the node is opened in the browser. This is not the amount of time it
then takes to display those children. The default value is 10000 milliseconds.

BROWSER_CHECK_NODE_TIME_LIMIT

This is the maximum time taken for Deja to verify if an entry is a leaf or a node.
The default value is 2000 milliseconds.

STANDARD_SECURITY_AUTHENTICATION

Defines the standard authentication mechanism used in the login panel. This can
have one of two values: simple or CRAM-MD5. The default value is CRAM-MD5.

CODE EXAMPLE A–1 General Parameters

# schema thread time limit in milliseconds (0 = no limit)
SCHEMA_THREAD_TIME_LIMIT=0
#
# manage referrals as entries (true or false)
REFERRALS_MANAGE_DSA=true
#
# max. number of nodes in browser tree (0 = no limit)
BROWSER_ENTRY_LIMIT=0
# max number of subnodes of a node in the browser tree (0 = no limit)
BROWSER_SUBENTRY_LIMIT=0
# time limit to load subnodes (in ms, 0 = no limit)
BROWSER_LOAD_SUBNODES_TIME_LIMIT=10000
# time limit to verify if entry is a leaf or an inner node (in ms, 0 = no limit)
BROWSER_CHECK_NODE_TIME_LIMIT=2000
#
# authentication mechanism
# supported values : CRAM-MD5, simple (cleartext password)
STANDARD_SECURITY_AUTHENTICATION=CRAM-MD5
# STANDARD_SECURITY_AUTHENTICATION=simple
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Standard LDAP Parameters
In this section of the Deja.properties file you can:

� specify which attribute values are hidden in Deja

� specify parameters for the login panel

� define standard searches

Hiding Attributes
STANDARD_ATTRIBUTES_CRYPTED

In the view, modify and create windows of Deja, some attribute values are
replaced by a localized text string. Specify the attributes you want to be hidden by
adding their names to the STANDARD_ATTRIBUTES_CRYPTEDlist. Attribute
names are separated by commas. By default the values for radiusppppasswd,
radiusloginpasswd, chappassword, radiusslippasswd, userpassword are hidden.

CODE EXAMPLE A–2 Standard Encrypted Attributes

#
# Standard Add/Modify/View
#
STANDARD_ATTRIBUTES_CRYPTED=radiusppppasswd, radiusloginpasswd, chappassword,
radiusslippasswd, userpassword

Login Parameters
STANDARD_LOGIN_SEARCH_FILTER

The search feature of the login panel operates using the filter defined with this
label. By default it is (|(cn=*{0}*)(uid=*{0}*)) . This is defined as either cn
or uid contains the search string typed by the user in the search text field.

STANDARD_LOGIN_MAX_SEARCH_RESULT

Specifies the maximum number of search results per naming context returned by a
login search. The default value is 55.

STANDARD_LOGIN_ALIASES
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Defines standard login aliases for Deja. To add an alias, remove the # from the
start of the line and see “Adding a Login Alias” on page 65 for information. The
syntax is:

STANDARD_LOGIN_ALIASES=alias; DN; alias; DN; ...

Adding a Login Alias
For example, if the user cn=Robert Travis, ou=sales,o=xyz,c=us wants to login
frequently, instead of typing the DN of the user, you can create an alias for him
called, for instance, rob. To create the alias:

♦ Remove the # from the start of the line and add the alias name and the DN for
the entry to the STANDARD_LOGIN_ALIASESdefinition:

STANDARD_LOGIN_ALIASES= rob; cn=Robert Travis,ou=sales,o=xyz,c=us

When Deja is restarted the alias is available in the Login panel.

CODE EXAMPLE A–3 Login Parameters

#
# Standard Login
#
STANDARD_LOGIN_SEARCH_FILTER= (|(cn=*{0}*)(uid=*{0}*))
STANDARD_LOGIN_MAX_SEARCH_RESULT= 55
# STANDARD_LOGIN_ALIASES= UserA_alias; userA_dn; UserB_alias; UserB_dn

Standard Search Parameters
To add a standard search to Deja, define it in the Standard Search section of the
Deja.properties file. Each type of search is declared in the
STANDARD_SEARCH_FILTERSdefinition. Each search is then defined on a separate
line. A search definition consists of the search name (for example,
STANDARD_SEARCH_FILTER_PERSON), the label that appears in the Search Type
option button (for example, STANDARD_SEARCH_FILTER_PERSON_IDENTIFIER),
and the search definition (for example, (&(objectclass=person)(cn=*{0}*)) ).

STANDARD_SEARCH_TABLE_LABELS

Contains a list of the attributes and header labels for the search results table. By
default the cn, telephoneNumber and mail attributes are listed.
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CODE EXAMPLE A–4 Standard Search Parameters

#
# Standard Search
#
STANDARD_SEARCH_FILTERS= STANDARD_SEARCH_FILTER_PERSON,
STANDARD_SEARCH_FILTER_LOCALITY, STANDARD_SEARCH_FILTER_ORGANIZATION,
STANDARD_SEARCH_FILTER_WILDCARD
STANDARD_SEARCH_FILTER_PERSON= STANDARD_SEARCH_FILTER_PERSON_IDENTIFIER,
(&(objectclass=person)(cn=*{0}*))
STANDARD_SEARCH_FILTER_LOCALITY= STANDARD_SEARCH_FILTER_LOCALITY_IDENTIFIER,
(l=*{0}*)
STANDARD_SEARCH_FILTER_ORGANIZATION=
STANDARD_SEARCH_FILTER_ORGANIZATION_IDENTIFIER, (|(o=*{0}*)(ou=*{0}*))
STANDARD_SEARCH_FILTER_WILDCARD= STANDARD_SEARCH_FILTER_WILDCARD_IDENTIFIER,
{0}
STANDARD_SEARCH_TABLE_LABELS= cn; STANDARD_SEARCH_TABLE_NAME_LABEL,
telephoneNumber; STANDARD_SEARCH_TABLE_PHONE_LABEL, mail;
STANDARD_SEARCH_TABLE_MAIL_LABEL

Adding a New Standard Search
To add a standard search for the uid attribute.

1. Declare the search definition in the STANDARD_SEARCH_FILTERSline:

STANDARD_SEARCH_FILTERS= STANDARD_SEARCH_FILTER_PERSON,
STANDARD_SEARCH_FILTER_LOCALITY,
STANDARD_SEARCH_FILTER_ORGANIZATION,
STANDARD_SEARCH_FILTER_WILDCARD, NEW_SEARCH_FILTER_UID

The label for the new search is NEW_SEARCH_FILTER_UID.

2. Define the search:

NEW_SEARCH_FILTER_UID= User ID, (&(objectclass=*)(uid=*{0}*))

The label to appear in the Search Type option button is User ID, and Deja
searches for entries containing the specified value for the attribute uid.

3. Add additional search results table labels:
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STANDARD_SEARCH_TABLE_LABELS= cn;
STANDARD_SEARCH_TABLE_NAME_LABEL, telephoneNumber;
STANDARD_SEARCH_TABLE_PHONE_LABEL, mail;

STANDARD_SEARCH_TABLE_MAIL_LABEL, uid;User ID

User ID is added to the search results table headings.

4. Close Deja and restart it.

You search type is added to the Standard Search panel.

Standard Create Parameters
When you paste an entry to the Create panel (see “Pasting an Entry to the Create
Panel” on page 23), the paste works in one of two ways:

� The paste action can remove information from the Create panel before pasting the
entry

� The paste action does not clear data from the Create panel before pasting. This is
useful when you want to create an entry that contains the characteristics of two or
more entries.

STANDARD_CREATE_PASTE_CLEAR_DATA

Specifies the type of paste. true indicates that data is cleared from the entry
before pasting. By default this is set to false .

STANDARD_CREATE_ALTERNATIVE_NAMING_ATTRIBUTES

If the naming attributes cannot be retrieved from the schema for the Standard
Create panel, the list of available naming attributes is taken from this definition.
By default the naming attributes are cn, o, ou, l, c, and dc.

CODE EXAMPLE A–5 Standard Create Parameters

#
# Standard Create
#
STANDARD_CREATE_PASTE_CLEAR_DATA=FALSE
#STANDARD_CREATE_PASTE_CLEAR_DATA=TRUE
#
# Alternate way to specify naming attributes if cannot be retrieved from schema
STANDARD_CREATE_ALTERNATIVE_NAMING_ATTRIBUTES=cn; o; ou; l; c; dc
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NIS Parameters
The NIS_MAPSdefinition contains a list of all the NIS maps displayed in Deja. The
parameters for each map are specified in a number of definitions. Map definitions
can be created by hand, or by using the dejasync command line utility. See
“Adding a NIS Map to Deja using dejasync ” on page 69 for information. See also
Appendix B, or the dejasync(1M) manpage. For each map listed in the in the
NIS_MAPSdefinition in the Deja.properties file, dejasync gets the
NIS_FILTER , NIS_DOMAIN, NIS_ROOT, NIS_NAMINGATTRand NIS_OCLASStokens
from the nis.mapping(4) file, and copies them to the map definition in the
Deja.properties file. If the tokens already exist in the Deja.properties file
they are updated by dejasync .

NIS_MAPS

Specifies the list of maps available in Deja. Each map name is followed by a
semicolon and the label that appears in the Map Name option button of the NIS
Search, Create or Modify panels. You can create a new map that is not present in
the nis.mapping file. The syntax is:

NIS_MAPS= map.name; map_label, map.name; map_label, ...

NIS_FILTER .map.name

Specifies the filter that is used in the NIS Search panel. This definition is
automatically generated if you use the dejasync utility.

NIS_DOMAIN.map.name

Specifies the label that appears in the NIS Create, Modify and Search panels. It
shows to which domain the NIS map applies. This definition is automatically
generated if you use the dejasync utility.

NIS_NAMINGATTR.map.name

Specifies the naming attributes that are available in the NIS Create panel. This is a
comma delimited list. This definition is automatically generated if you use the
dejasync utility.

NIS_ROOT.map.name

Specifies the DN of the root entry used for NIS searches. It is also the default
parent entry displayed in the NIS Create panel. This definition is automatically
generated if you use the dejasync utility.

NIS_OCLASS.map.name
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Specifies the default object classes that are added to an entry definition in the NIS
Create Panel. This is a comma delimited list. This definition is automatically
generated if you use the dejasync utility.

NIS_LIST .map.name

Contains names of the attributes and header labels for the NIS search results table.
The syntax is:

NIS_LIST. map.name= attribute; header_label, attribute; header_label, ...

NIS_ADD.map.name

Specifies labels and syntax for attributes in the NIS Create panel. The syntax is:

NIS_ADD. map.name= attribute; label; syntax, attribute; label; syntax, ...

Where syntax is one of the four basic input types (int , string , crypt and
ipaddr ). If a syntax isn’t specified, the default value, string , is used. Specifying
a syntax is useful to constrain user input:

� crypt is a text field where each typed character is replaced with *.

� string is a text field that accepts any character.

� int is a text field that accepts only integer numbers.

� ipaddr consists of four int fields, in the format int.int.int.int .

NIS_LIST.default

Contains the names of the attributes listed in NIS search results table if NIS_LIST
is not defined for a map.

Adding a NIS Map to Deja using dejasync
For information about dejasync , see Appendix B, or the dejasync(1M) manpage.
To add a NIS map to Deja from the nis.mapping file using dejasync :

1. Login as root or become superuser on the directory server.

2. Add the name of the map, and the label you want to be used in the NIS Maps
option button, to the NIS_MAPSdefinition.

The map must be defined in the nis.mapping file. For example to add the
ethers.byname map to Deja using the label Ethers, the NIS_MAPSdefinition
will look like this:

NIS_MAPS= ethers.byname;Ethers,
passwd.byname;NIS_MAP_USERS_CHOICE,
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mail.aliases;NIS_MAP_ALIASES_CHOICE,
hosts.byname;NIS_MAP_HOSTS_CHOICE,
group.byname;NIS_MAP_GROUPS_CHOICE

3. Run dejasync by typing:

prompt# /opt/SUNWconn/ldap/sbin/dejasync -d Deja_properties_directory
-n NIS_mapping_file

Where:

Deja_properties_directory specifies the directory containing the Deja.properties
file. By default this is /opt/SUNWconn/ldap/html .

NIS_mapping_file specifies the filename of the NIS mapping file. By default this is
/etc/opt/SUNWconn/ldap/current/mapping/nis.mapping .

The dejasync utility reads the map declarations in NIS_MAPS, reads the
definitions from the nis.mapping file, and updates or adds the corresponding
map definitions to the Deja.properties file.

For the example, the following map definition is added at the end of the
Deja.properties file:

NIS_OCLASS.ethers.byname= ieee802Device
NIS_FILTER.ethers.byname=
(&(objectClass=ieee802Device)(cn=$NIS_KEY))
NIS_NAMINGATTR.ethers.byname=cn
NIS_ROOT.ethers.byname=dc=xyz,dc=com
NIS_DOMAIN.ethers.byname=xyz.com

4. Optionally add NIS_LIST and NIS_ADD definitions for the new map.

Exit from Deja and restart it to use the new map.

For the example, the following definitions are added for NIS_LIST and NIS_ADD:
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NIS_LIST.ethers.byname=cn;Host Name, macAddress;Ethernet Address,
description;Comments
NIS_ADD.ethers.byname=cn;Host Name, macAddress;Ethernet Address,
description;Comments

CODE EXAMPLE A–6 Default NIS Map Definitions

#
# list of supported maps
#
NIS_MAPS=passwd.byname;NIS_MAP_USERS_CHOICE,
mail.aliases;NIS_MAP_ALIASES_CHOICE, hosts.byname;NIS_MAP_HOSTS_CHOICE,
group.byname;NIS_MAP_GROUPS_CHOICE
#
# passwd map
#
NIS_FILTER.passwd.byname= (&(objectclass=posixAccount)(uid=$NIS_KEY))
NIS_DOMAIN.passwd.byname= xyz_users.com
NIS_NAMINGATTR.passwd.byname=cn
NIS_ROOT.passwd.byname= dc=xyz_users,dc=com
NIS_OCLASS.passwd.byname= posixaccount,person
NIS_LIST.passwd.byname=cn;NIS_USER_CN_ATTR_LABEL, uid;NIS_UID_ATTR_LABEL,
uidNumber;NIS_UIDNUMBER_ATTR_LABEL, gidNumber;NIS_GIDNUMBER_ATTR_LABEL,
homeDirectory;NIS_HOMEDIRECTORY_ATTR_LABEL
NIS_ADD.passwd.byname=cn;NIS_USER_CN_ATTR_LABEL, sn;NIS_SN_ATTR_LABEL,
uid;NIS_UID_ATTR_LABEL, uidNumber;NIS_UIDNUMBER_ATTR_LABEL;int,
gidNumber;NIS_GIDNUMBER_ATTR_LABEL;int,
homeDirectory;NIS_HOMEDIRECTORY_ATTR_LABEL,
userPassword;NIS_USERPASSWORD_ATTR_LABEL;crypt,
loginShell;NIS_LOGINSHELL_ATTR_LABEL, description;NIS_DESCRIPTION_ATTR_LABEL
#
# alias map
#
NIS_FILTER.mail.aliases= (&(objectclass=nisMailAlias)(cn=$NIS_KEY))
NIS_DOMAIN.mail.aliases= xyz_aliases.com
NIS_NAMINGATTR.mail.aliases=cn
NIS_ROOT.mail.aliases= dc=xyz_aliases,dc=com
NIS_OCLASS.mail.aliases= nismailalias
NIS_LIST.mail.aliases= cn;NIS_ALIAS_CN_ATTR_LABEL,
rfc822mailMember;NIS_RFC822MAILMEMBER_ATTR_LABEL
NIS_ADD.mail.aliases= cn;NIS_ALIAS_CN_ATTR_LABEL,
rfc822mailMember;NIS_RFC822MAILMEMBER_ATTR_LABEL
#
# host map
#
NIS_FILTER.hosts.byname= (&(objectclass=ipHost)(cn=$NIS_KEY))
NIS_DOMAIN.hosts.byname= xyz_hosts.com
NIS_NAMINGATTR.hosts.byname=cn
NIS_ROOT.hosts.byname= dc=xyz_hosts,dc=com
NIS_OCLASS.hosts.byname= ipHost
NIS_LIST.hosts.byname= cn;NIS_HOST_CN_ATTR_LABEL,

(continued)
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ipHostNumber;NIS_IPHOSTNUMBER_ATTR_LABEL, macaddress;NIS_MACADDRESS_ATTR_LABEL
NIS_ADD.hosts.byname= cn;NIS_HOST_CN_ATTR_LABEL,
ipHostNumber;NIS_IPHOSTNUMBER_ATTR_LABEL;ipaddr,
macaddress;NIS_MACADDRESS_ATTR_LABEL, l;NIS_L_ATTR_LABEL
#
# group map
#
NIS_FILTER.group.byname= (&(objectclass=posixGroup)(cn=$NIS_KEY))
NIS_DOMAIN.group.byname= xyz_groups.com
NIS_NAMINGATTR.group.byname=cn
NIS_ROOT.group.byname= dc=xyz_groups,dc=com
NIS_OCLASS.group.byname= posixGroup
NIS_LIST.group.byname= cn;NIS_GROUP_CN_ATTR_LABEL,
gidNumber;NIS_GIDNUMBER_ATTR_LABEL, memberUid;NIS_MEMBERUID_ATTR_LABEL
NIS_ADD.group.byname= cn;NIS_GROUP_CN_ATTR_LABEL,
gidNumber;NIS_GIDNUMBER_ATTR_LABEL;int, memberUid;NIS_MEMBERUID_ATTR_LABEL

NIS_LIST.default= cn;NIS_CN_ATTR_LABEL

RADIUS Parameters
RADIUS Search Panel Definitions
To add a RADIUS search to Deja, define it in the Radius Search Panel section of the
Deja.properties file. Remote User searches are declared in the
RADIUS_RU_SEARCHdefinition, and Remote Access Server searches are defined in
the RADIUS_RAS_SEARCHdefinition. Each search is then defined on a separate line.
A search definition consists of the search name (for example, s_user ), the label that
appears in the Search Type option button (for
example, RADIUS_RU_SEARCH_USER_LABEL), and the search definition (for example,
(& (objectclass=remoteuser)(uid={$uid;RADIUS_RU_UID_ATTR_LABEL$}))
).

RADIUS_COMPLEX_SEARCH_LIST

Contains a list of the attributes and header labels for the complex search results
table. By default the cn, iphostnumber and uid attributes are listed.

72 Sun Directory Services 3.1 User’s Guide ♦ June 1998



Adding a RADIUS Remote Access Server Search
To add a RADIUS Remote Access Server search for the mail attribute.

1. Declare the search definition in the RADIUS_RAS_SEARCHline:

RADIUS_RAS_SEARCH=s_name;RADIUS_RAS_SEARCH_NAME_LABEL,
s_addr;RADIUS_RAS_SEARCH_IPADDR_LABEL, s_mail;Search by Email

The name for the new search is s_mail , and the label that appears in the Search
Type option button is Search by Email.

2. Define the search:

RADIUS_RAS_FILTER.s_mail=
(& (objectclass=nas) (uid={$uid;Email;string$}) )

The expression {$uid;Email;string$} tells Deja that for this search, the user
input is a text string (string ), the label to appear by the text field is Email
(Email ), and that the search text string is a user id (uid ).

3. Define the headings for the search results table:

RADIUS_RAS_LIST.s_mail= cn;RADIUS_RAS_CN_ATTR_LABEL, uid;Email

If you do not specify a RADIUS_RAS_LIST for the search, the default headings
are used (RADIUS_RAS_LIST.default ).

4. Close Deja and restart it.

You search type is added to the RADIUS Remote Access Server Search panel.

CODE EXAMPLE A–7 RADIUS Search Definitions

#
# Radius SEARCH PANEL
#
# Searches defined for Remote Users
RADIUS_RU_SEARCH=s_user;RADIUS_RU_SEARCH_USER_LABEL,
s_name;RADIUS_RU_SEARCH_NAME_LABEL,
l_bl_acc;RADIUS_RU_LIST_BLOCKED_ACCOUNTS_LABEL ,
l_ppp;RADIUS_RU_LIST_PPP_USER_LABEL, l_slip;RADIUS_RU_LIST_SLIP_USER_LABEL,
l_login;RADIUS_RU_LIST_LOGIN_USER_LABEL, s_n_u;RADIUS_RU_SEARCH_NAME_UID_LABEL

(continued)
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# Associated filters pour Remote Users searches
RADIUS_RU_FILTER.s_user= (&
(objectclass=remoteuser)(uid={$uid;RADIUS_RU_UID_ATTR_LABEL$}))
RADIUS_RU_FILTER.s_name= (&
(objectclass=remoteuser)(cn={$cn;RADIUS_RU_CN_ATTR_LABEL$}))
RADIUS_RU_FILTER.l_bl_acc= (&
(objectclass=remoteuser)(radiusAuthFailedAccess>=$RADIUS_MAX_FAIL))
RADIUS_RU_FILTER.l_ppp= (&
(objectclass=remoteuser)(radiusPppProfile=*)(radiusPppPasswd=*))
RADIUS_RU_FILTER.l_slip= (&
(objectclass=remoteuser)(radiusSlipProfile=*)(radiusSlipPasswd=*))
RADIUS_RU_FILTER.l_login= (&
(objectclass=remoteuser)(radiusLoginProfile=*)(radiusLoginPasswd=*))
RADIUS_RU_FILTER.s_n_u= (&
(objectclass=remoteuser)(cn={$cn;RADIUS_RU_CN_ATTR_LABEL$})(uid={$uid;RADIUS_R
U_UID_ATTR_LABEL$}))

# Attributes to be included (listed) in the searches’ results
RADIUS_RU_LIST.s_user= cn;RADIUS_RU_CN_ATTR_LABEL,
uid;RADIUS_RU_UID_ATTR_LABEL,
framedProtocol;RADIUS_RU_FRAMEDPROTOCOL_ATTR_LABEL
RADIUS_RU_LIST.l_bl_acc= cn;RADIUS_RU_CN_ATTR_LABEL,
uid;RADIUS_RU_UID_ATTR_LABEL,
radiusAuthFailedAccess;RADIUS_RU_RADIUSAUTHFAILEDACCESS_ATTR_LABEL
RADIUS_RU_LIST.default= cn;RADIUS_RU_CN_ATTR_LABEL,
uid;RADIUS_RU_UID_ATTR_LABEL

# Searches defined for RASes (Remote Access Servers)
RADIUS_RAS_SEARCH=s_name;RADIUS_RAS_SEARCH_NAME_LABEL,
s_addr;RADIUS_RAS_SEARCH_IPADDR_LABEL

# Associated filters pour NAS searches
RADIUS_RAS_FILTER.s_name= (&
(objectclass=NAS)(cn={$cn;RADIUS_RAS_CN_ATTR_LABEL$}))
RADIUS_RAS_FILTER.s_addr= (&
(objectclass=NAS)(iphostnumber={$iphostnumber;RADIUS_RAS_IPHOSTNUMBER_ATTR_LAB
EL;ipaddr$}))

# Attributes to be included (listed) in the searches’ results
RADIUS_RAS_LIST.default= cn;RADIUS_RAS_CN_ATTR_LABEL,
iphostnumber;RADIUS_RAS_IPHOSTNUMBER_ATTR_LABEL

# Attributes to be listed in case of a complex search
RADIUS_COMPLEX_SEARCH_LIST=cn;RADIUS_CN_ATTR_LABEL,
iphostnumber;RADIUS_RAS_IPHOSTNUMBER_ATTR_LABEL, uid;RADIUS_RU_UID_ATTR_LABEL
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RADIUS Create Panel Definitions
You can define alternate names for attributes that are displayed in the Choose
Attributes list of the RADIUS Create panel. You can also restrict user input to one of
the four basic input types (int , string , crypt and ipaddr ). The default input_type
is string .

RADIUS_RU_ADD_COMMONdefines attributes for Remote User Entries that are
common to all remote user profiles, and RADIUS_RAS_ADD_COMMONdefines
attributes for Remote Access Server entries that are common to all remote user
profiles. The syntax of an attribtue definition is:

RADIUS_RAS_ADD_COMMON=attribute_name; label; input_type, ...

where:

attribute_name is the name of an attribute

label is the name you want to appear in the Choose Attributes list instead of the
attribute name, and

input_type is one of the four basic input types (int , string , crypt and ipaddr ).
The default input_type is string .

CODE EXAMPLE A–8 RADIUS Create Panel Definitions

# Radius ADD PANEL

RADIUS_RU_ADD_COMMON= uid;RADIUS_RU_UID_ATTR_LABEL,
grpCheckInfo;RADIUS_RU_GRPCHECKINFO_ATTR_LABEL,
grpReplyInfo;RADIUS_RU_GRPREPLYINFO_ATTR_LABEL,
framedIPAddress;RADIUS_RU_FRAMEDIPADDRESS_LABEL;ipaddr,
userPassword;RADIUS_RU_USERPASSWORD_LABEL;crypt
RADIUS_RAS_ADD_COMMON=
iphostNumber;RADIUS_RAS_IPHOSTNUMBER_ATTR_LABEL;ipaddr,
sharedKey;RADIUS_RAS_SHAREDKEY_LABEL;crypt

RADIUS Profiles
Three RADIUS Remote User profiles are supplied in the default Deja.properties
file. There are no Remote Access Server profiles defined in the default
Deja.properties file. You can add more profiles, or add attributes to the existing
profiles, but you should not remove default attributes in the existing profiles.

RADIUS_RU_PROFILE / RADIUS_RAS_PROFILE
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Specifies the RADIUS profiles available to Deja. The default profiles are SLIP, PPP
and LOGIN. The syntax is:

RADIUS_RU_PROFILE= profile_name; label, profile_name; label ...
RADIUS_RAS_PROFILE= profile_name; label, profile_name; label ...

Where profile_name is the name of the profile, and label is the label that appears in
the Create or Modify panels.

RADIUS_RU_ADD.profile_name / RADIUS_RAS_ADD.profile_name

Defines the default attributes that are added to the entry automatically. The syntax
is:

RADIUS_RU_ADD.profile_name= attribute; label; input_type, ...
RADIUS_RAS_ADD.profile_name= attribute; label; input_type, ...

Where attribute is the attribute you want automatically added to the entry
definition, label is the name to appear in the entry definition, and input_type is one
of the four basic input types (int , string , crypt and ipaddr ). The default
input_type is string .

CODE EXAMPLE A–9 RADIUS Profile Definitions

# Profiles defined for Remote Users (RU)
RADIUS_RU_PROFILE= ppp_p;RADIUS_RU_PPP_PROFILE_LABEL,
slip_p;RADIUS_RU_SLIP_PROFILE_LABEL, login_p;RADIUS_RU_LOGIN_PROFILE_LABEL

# Mandatory RU profile attributes (you can edit the next line by ADDING
attributes, but
# NEVER erase the attributes that are given by default)
RADIUS_RU_ADD.ppp_p=
radiuspppprofile;RADIUS_RU_RADIUSPPPPROFILE_ATTR_LABEL;int,
radiusPppPasswd;RADIUS_RU_RADIUSPPPPASSWD_ATTR_LABEL;crypt
RADIUS_RU_ADD.slip_p=
radiusSlipprofile;RADIUS_RU_RADIUSSLIPPROFILE_ATTR_LABEL;int,
radiusSlipPasswd;RADIUS_RU_RADIUSSLIPPASSWD_ATTR_LABEL;crypt
RADIUS_RU_ADD.login_p=
radiusLoginprofile;RADIUS_RU_RADIUSLOGINPROFILE_ATTR_LABEL;int,
radiusLoginPasswd;RADIUS_RU_RADIUSLOGINPASSWD_ATTR_LABEL;crypt

# Profiles defined for Remote Access Servers (RAS)
#RADIUS_RAS_PROFILE= no defined profiles

# Mandatory RAS profile attributes
#RADIUS_RAS_ADD.??= no defined profiles

(continued)
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RADIUS General Parameters
The following general parameters are defined for RADIUS. The
RADIUS_RU_OCLASS, RADIUS_RAS_OCLASS, RADIUS_RU_ROOT, RADIUS_RU_ROOT
and RADIUS_MAX_FAIL definitions can be automatically generated from the
radius.mapping(4) file by the dejasync utility. See Appendix B, or the
dejasync(1M) manpage for information.

RADIUS_RU_OCLASS

Specifies the object class associated with the RADIUS Remote User entry type. A
single object class is required for each type. This definition is automatically
generated if you use the dejasync utility. The default object class is remoteuser.

RADIUS_RAS_OCLASS

Specifies the object class associated with the RADIUS Remote Access Server entry
type. A single object class is required for each type. This definition is automatically
generated if you use the dejasync utility. The default object class is nas.

RADIUS_RU_ROOT

Specifies the DN of the root entry used for RADIUS Remote User searches. It is
also the default parent entry displayed in the RADIUS Create panel. This
definition is automatically generated if you use the dejasync utility. The default
value is o=xyz_remote_users,c=us.

RADIUS_RAS_ROOT

Specifies the DN of the root entry used for RADIUS Remote Access Server
searches. It is also the default parent entry displayed in the RADIUS Create panel.
This definition is automatically generated if you use the dejasync utility. The
default value is o=xyz_ras,c=us.

RADIUS_RU_NAMINGATTR

Specifies the naming attributes that are available in the RADIUS Create panel for
Remote User entries. This is a comma delimited list. The default naming attributes
are cn and uid.

RADIUS_RAS_NAMINGATTR
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Specifies the naming attributes that are available in the RADIUS Create panel for
Remote Access Server entries. This is a comma delimited list. The default naming
attribute is cn.

RADIUS_MAX_FAIL

Specifies search limit for the RADIUS Remote User blocked accounts search. The
blocked accounts search returns entries that have a value for the attribute
radiusAuthFailedAccess greater than or equal to the value of RADIUS_MAX_FAIL.
The default value is 4. This definition is automatically generated if you use the
dejasync utility.

CODE EXAMPLE A–10 RADIUS General Parameters

# Add object classes (a single objectclass is accepted for every type)
RADIUS_RU_OCLASS= remoteuser
RADIUS_RAS_OCLASS= nas

# Radius COMMON to ADD and SEARCH Panels
# Root DN: a single RootDN is accepted for every type
RADIUS_RU_ROOT= o=xyz_remote_users,c=us
RADIUS_RAS_ROOT= o=xyz_ras,c=us

# Naming attributes: a comma (,) separated list is accepted for every type
RADIUS_RU_NAMINGATTR= cn, uid
RADIUS_RAS_NAMINGATTR= cn
RADIUS_MAX_FAIL= 4
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APPENDIX B

dejasync Command Reference

dejasync is a command line utility that synchronises the Deja.properties files
with the NIS and RADIUS mapping files (nis.mapping and radius.mapping ) on
the directory server. Use it when you have made modifications to the mapping files
and you want the changes to be carried over into Deja.

It creates or updates tokens in the Deja.properties file depending on tokens that
exist in the Deja.properties file.

For information on the nis.mapping and radius.mapping files, see the relevant
manpages; nis.mapping(4) and radius.mapping(4) .

dejasync also backs up the Deja.properties file.

You must be logged in as root or superuser to run dejasync .

Note - Running dejasync implies that you accept all changes that may be made to
the Deja.properties file.

nis.mapping File
dejasync gets from the Deja.properties file the list of maps managed by Deja
for NIS. These are lines that start with the NIS_MAPStoken.

For each map in the Deja.properties file, dejasync creates a new map
definition by copying the following tokens from the nis.mapping file into the
Deja.properties file:

� NIS_FILTER

� NIS_DOMAIN
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� NIS_ROOT

� NIS_NAMINGATTR

� NIS_OCLASS

If these tokens exist in the Deja.properties file, dejasync updates them. If they
do not exist, it creates them.

radius.mapping File
dejasync copies the following tokens from the radius.mapping file to the
Deja.properties file:

� RADIUS_RU_OCLASS

� RADIUS_RAS_OCLASS

� RADIUS_RU_ROOT

� RADIUS_RAS_ROOT

� RADIUS_MAX_FAIL

If these tokens exist in the Deja.properties file it updates them. If they do not
exist it creates them.

Syntax
The command line options for dejasync are:

/opt/SUNWconn/ldap/sbin/dejasync [-v] [-d Deja_properties_directory]
[-n NIS_mapping_file] [-r RADIUS_mapping_file]

Command Line Options
-v

Enables verbose mode.

-d Deja_properties_directory

Specifies the directory containing the Deja.properties file. By default this is
/opt/SUNWconn/ldap/html .
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-n NIS_mapping_file

Specifies the filename of the NIS mapping file. By default this is
/etc/opt/SUNWconn/ldap/current/mapping/nis.mapping .

-r RADIUS_mapping_file

Specifies the filename of the RADIUS mapping file. By default this is
/etc/opt/SUNWconn/ldap/current/mapping/radius.mapping .
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D
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Deja
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attributes from an entry, 18
entry, 20

display options, 11
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as a Java application, 9
without a web server, 9

displaying remotely
with any Web Server, 8
with Sun WebServer, 8

icons, 2, 3
login panel, 9
modify panel, 24, 42
modifying

attributes in an entry, 19
entry, 24, 42

naming
attributes in an entry, 17
entry, 16, 34, 40

pasting an entry, 22
pasting an entry to the create panel, 23
properties, 11
reconnecting, 13
refreshing the browser window, 14
removing objectclasses from an entry, 17
rename panel, 25
renaming an entry, 25
restoring an entry, 24
search constraints, 29
search results list, 30, 37, 51
searching for an entry, 26, 35, 44
toolbar icons, 2, 3
user properties, 12
view window, 30
view window, closing, 31
view window, copying an entry from, 31
view window, highlighting an entry in the

browser, 31
viewing an entry, 30

Deja.properties
adding a login alias, 65
adding a NIS map, 69
adding a RADIUS search, 73
adding a standard search, 66
file structure, 61
general parameters, 62
hiding attributes, 64
labels, 62

login parameters, 64
NIS parameters, 68
RADIUS create parameters, 75
RADIUS general parameters, 77
RADIUS parameters, 72
RADIUS profiles, 75
RADIUS search parameters, 72
standard create parameters, 67
standard LDAP parameters, 64
standard search parameters, 65

dejasync command reference, 79
dejasync syntax, 80
delete panel, 20
deleting

attributes from an entry, 18
entry, 20

directory server, starting, 6
displaying Deja, 8, 9
displaying the Web Gateway, 53
dsservd daemon, starting, 6
dswebd daemon, starting, 6

E
entry

adding, 15, 33
copying, 22
creating, 15, 33, 39
cutting, 22
deleting, 20
modifying, 24, 42
modifying with the Web Gateway, 58
naming, 16, 34, 40
pasting, 22
pasting to the create panel, 23
reading with the Web Gateway, 58
renaming, 25
restoring, 24
searching for, 26, 35, 44
searching for with the Web Gateway, 56
viewing, 30
viewing with the Web Gateway, 58

entry, root
creating, 19
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F
filter definitions, 27

H
highlighting an entry in the browser from a

view window, 31

I
icons, Deja, 2, 3
int, 69
IP address RAS search, 50
ipaddr, 69

J
JAVA_HOME, 9

L
LDAP filter, see filter definitions,
LDAP server, starting, 6
LDAP/HTTP web gateway, see Web Gateway,
login

Deja, 9
Web Gateway, 58

login name remote user search, 45
LOGIN users remote user search, 48

M
modify panel, 24, 42
modifying

attributes in an entry, 19
entry, 24, 42
entry with the Web Gateway, 58

N
name and email address remote user

search, 49
name RAS search, 50
naming an entry, 16, 34, 40
naming attributes, 17
NIS functions

creating an entry, 33
naming an entry, 34
search results list, 37

searching for an entry, 35
nis.mapping file, 79

O
objectclasses

adding to an entry, 17
removing from an entry, 17
selecting for an entry, 16

opening a new Deja window, 13

P
pasting an entry, 22
pasting an entry to the create panel, 23
port number, 12
PPP users remote user search, 47
profile, selecting, 12

R
RADIUS functions

creating an entry, 39
modifying an entry, 42
naming an entry, 40
search results list, 51
searching

complex, 51
RAS IP address, 50
RAS name, 50
remote user blocked accounts, 46
remote user login name, 45
remote user LOGIN users, 48
remote user name and email

address, 49
remote user PPP users, 47
remote user SLIP users, 48
remote user user name, 46

searching for an entry, 44
radius.mapping file, 80
RAS

IP address search, 50
name search, 50

reading an entry with the Web Gateway, 58
reconnecting Deja, 13
refreshing the browser window, 14
remote user

blocked accounts search, 46
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login name search, 45
LOGIN users search, 48
name and email address search, 49
PPP users search, 47
SLIP users search, 48
user name search, 46

removing objectclasses from an entry, 17
renaming an entry, 25
restoring an entry, 24

S
searching

for an entry using Deja, 26, 35, 44
for an entry using the Web Gateway, 56
NIS entry, 36
RADIUS entry, 51
RAS, 49

IP address, 50
name, 50

remote user, 45
blocked accounts, 46
login name, 45
LOGIN users, 48
name and email address, 49
PPP users, 47
SLIP users, 48
user name, 46

SLIP users remote user search, 48

string, 69

U
user name remote user search, 46

V
value

assigning to an attribute, 17
deleting from an attribute, 18
modifying for an attribute, 19

view window
closing, 31
copying an entry from, 31
highlighting an entry in the browser, 31

viewing an entry, 30
viewing an entry with the Web Gateway, 58

W
Web Gateway

daemon, starting, 6
displaying, 53
login, 58
modifying an entry, 58
searching the directory, 56
viewing an entry, 58
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